
July 2003 Telelogic Ta

Chapter
6 Tutorial: Applying SDL-

92 to the DemonGame
This tutorial will teach you how to take advantage of the object-ori-
ented extensions that have been added to SDL, also known as SDL-
92. The example that has been selected for this purpose is the well 
known DemonGame, which you should have already practiced on, 
in the previous tutorials presented in chapter 3, Tutorial: The Edi-
tors and the Analyzer and chapter 4, Tutorial: The SDL Simulator.

In order to learn how to take advantage of the object oriented ex-
tensions in SDL, read through this entire chapter. As you read, you 
should perform the exercises on your computer system as they are 
described.
u 4.5 SDL Suite Getting Started gs-s1 227



Chapter 6 Tutorial: Applying SDL-92 to the DemonGame
Purpose of This Tutorial
The purpose of this tutorial is to make you familiar with the essential 
object-oriented SDL functionality in the SDL suite tools. This tutorial 
is designed as a guided tour through the SDL suite, where a number of 
hands-on exercises should be performed on your computer as you read 
this chapter. 

We have on purpose selected a simple example that should be easy to 
understand. It is assumed that you have a basic knowledge about SDL 
— this chapter is not a tutorial on SDL.

The example is DemonGame, which was used in the earlier tutorials in 
this volume. It is assumed that you have performed the exercises in 
chapter 3, Tutorial: The Editors and the Analyzer as well as chapter 4, 
Tutorial: The SDL Simulator before starting with this tutorial.

Note: Platform differences

This tutorial, and the others that are possible to run on both the 
UNIX and Windows platform, are described in a way common to 
both platforms. In case there are differences between the platforms, 
this is indicated by texts like “on UNIX”, “Windows only”, etc. 
When such platform indicators are found, please pay attention only 
to the instructions for the platform you are running on.

Normally, screen shots will only be shown for one of the platforms, 
provided they contain the same information for both platforms. This 
means that the layout and appearance of screen shots may differ 
slightly from what you see when running the SDL suite in your en-
vironment. Only if a screen shot differ in an important aspect be-
tween the platforms will two separate screen shots be shown. 
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 Applying SDL-92 to the DemonGame
Applying SDL-92 to the DemonGame
In the previous tutorials, you have practiced using some of the basic lan-
guage elements in SDL; all of these elements were already defined in 
the non-object-oriented version of SDL, known as SDL-88.

To introduce SDL-92 to you, we have prepared a number of exercises 
in which you will add features to the DemonGame. You will do this by 
redefining and adding properties to the process Game in an object-ori-
ented fashion. 

We will introduce the following SDL-92 language constructs:

• Process types
– Inheriting process types and adding properties
– Virtual and redefined process types
– Virtual and redefined transitions

• Packages
– Using packages
– Reusing packages

• Block types
– Inheriting block types and adding properties.

Some Preparatory Work
Instead of continue working on the original DemonGame system, we 
suggest you to continue from a version that is better designed for intro-
ducing SDL-92. The changes that have been made are the following:

• All signals from the environment (Newgame, Endgame, Probe, 
Result) are now directed to the administrating process Main, that 
will send them further to the Game process, if there is such a pro-
cess.

• The Bump signal is also sent to the process Main, which in turn 
transfers it to the Game process. This eliminates the annoying be-
havior when a signal is sent to a nonexisting receiver.

Note:

In this chapter, the term SDL-92 denotes the object-oriented SDL 
that was introduced in the 1992 version of the language. These ob-
ject-oriented features remain unchanged in SDL-96.
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Chapter 6 Tutorial: Applying SDL-92 to the DemonGame
• Signal routes and signal lists have been updated to reflect the new 
routing of signals.

• The internal signal GameOver is really not necessary and is there-
fore replaced by the signal EndGame.

From the user’s point of view, the system will show the same function-
ality as before, but is more robust.

The new versions of the block GameBlock and the process Main are de-
picted below, in Figure 154 and Figure 155. 

To use the new version:

1. Make a new empty directory sdl92 of your own (under 
~/demongame on UNIX, and under 
C:\Telelogic\SDL_TTCN_Suite4.5\work in Windows).

2. Copy all files in the directory 
$telelogic/sdt/examples/demongame/sdl92/process_type 
(on UNIX), or 
C:\Telelogic\SDL_TTCN_Suite4.5\sdt\examples\demongam
e\sdl92\process_type (in Windows), to this new directory.

3. Start the SDL suite and open the system file demongame.sdt in 
this new directory with the Organizer. (You will find copies of the 
diagrams building up the complete system).

You should recognize the system DemonGame, with the modifications 
as described above.

Note: Installation directory

On UNIX, the Telelogic Tau installation directory is pointed out 
by the environment variable $telelogic. If this variable is not 
set in your UNIX environment, you should ask your system manag-
er or the person responsible for the Telelogic Tau environment at 
your site for instructions on how to set this variable correctly.

In Windows, the Telelogic Tau installation directory is assumed 
to be C:\Telelogic\SDL_TTCN_Suite4.5 throughout this tu-
torial. If you cannot find this directory on your PC, you should ask 
your system manager or the person responsible for the Telelogic Tau 
environment at your site for the correct path to the installation direc-
tory.
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 Some Preparatory Work
Nearly all versions of the diagrams shown in the following exercises are 
available in the directory you created above. You can either draw a di-
agram to learn how to use SDL-92 in the SDL Editor, or copy (or con-
nect to) the pre-made version of the diagram if you do not wish to do 
this.

Figure 154: The block GameBlock, redesigned

The exact layout of your diagrams may differ slightly from the above.

Block GameBlock 1(1)

Main(1,1)

Game(0,1)

C1
R1

Newgame,
Endgame,
Probe,
Result

R5

EndGame,
Probe,
Result,
Bump

R2

Win,Lose,Score
C2

C3
RBump

Bump
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Figure 155: The process Main, redesigned

The exact layout of your diagrams may differ slightly from the above.

Process Main 1(1)

DCL
GameP Pid;

Game_Off

Newgame

Game

GameP:=
Offspring

Game_On

Game_On

Bump

Bump
TO GameP

Game_On

Probe

Probe
TO GameP

Game_On

Result

Result
TO GameP

Game_On

Endgame

EndGame
TO GameP

GameP:=
null

Game_Off
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Creating a Process Type from a Process

What You Will Learn
• To change a process diagram to a process type
• To refer to and instantiate a process type
• To interconnect the process type with a block and other processes 

(types), using gates
• To define transitions as virtual

Changing into a Process Type
To facilitate the introduction of new features, we will start by general-
izing the process Game, by changing it to a process type, that you later 
on will be in a position to specialize or redefine.

1. Open the process Game and change the diagram type from process 
to process type, simply by selecting the diagram heading symbol 
and editing the text in it to say “Process Type Game”.

2. From the SDL Editor’s File menu, save the diagram Process Type 
Game on a new file, e.g. new_game.spt using the Save As com-
mand. Edit the file name in the file selection dialog and click OK. 
(The existing *.spt files are copies of the complete system that 
comes with the examples in the SDL suite.)

3. Raise the Organizer window.

Figure 156: Changing the diagram type
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You may notice that the reference symbol has been changed to 
Process Type Game, and marked as having no reference in the par-
ent diagram. Also, the old process Game is marked as unconnected. 
Do not bother about that for the moment – it will be replaced by an 
instantiation symbol, which will be explained later.

4. Open the diagram block GameBlock. Change it so that the process 
reference Game is changed to an instantiation of the process type 
Game. The syntax is: “Game(0,1):Game” (You are allowed to add 
newlines to have the text fit into the symbol.)

– Before you have started text editing, the text cursor is not flash-
ing. Pressing <Delete> at this stage deletes the whole selected 
symbol. Once text editing has started, the text cursor is flashing 
and pressing <Delete> only deletes a character.

5. As soon as you deselect the symbol, one text rectangle appears for 
each connection point to the signal routes. Name the connections 
points for instance G2 and G5:

Figure 157: Invalid reference as shown in the Organizer
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 Creating a Process Type from a Process
6. Also add a process type reference symbol with the name Game. The 
block diagram should now look like this:

7. Save the block diagram on a new file, e.g. new_gameblock.sbk 
(use Save As as before).

Figure 158: Naming the connection points

Figure 159: The resulting block

Block GameBlock 1(1)

Main(1,1)

Game(0,1):Game

Game

C1
R1

Newgame,
Endgame,
Probe,
Result

R5

EndGame,
Probe,
Result,
Bump

R2

Win,Lose,Score
C2

C3
RBump

Bump

G5
G2
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Inserting Gates and Virtual Transitions
You will now finish the process type Game. You are recommended to 
do this by following the editing instructions described below. If you 
prefer, you can instead connect to the finished version of the diagram 
(see “Connecting to the Finished Diagram” on page 238), but you 
should in any case read through the text below.

Editing the Process Type Diagram

1. Go back to the process type Game in the SDL Editor. The connec-
tion to the signal routes must be defined using gate symbols, named 
in accordance to the connection points you just defined.

2. Gate symbols are to be connected to the frame symbol. If you want 
to connect gates to the left or top of the frame, you must first select 
the frame and drag it down and/or right.

Figure 160: Adjusting the frame symbol

Select the 
frame and 
drag.
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 Creating a Process Type from a Process
3. For each of the gates G2 and G5, add a gate symbol and fill in the 
name and the signal list. 

– The gate symbol is the one who looks like an arrow. Remember 
that the Status Bar displays the type of a symbol when you point 
to or select it in the symbol menu.

– To direct a gate to the frame, you must add a gate, then Redirect 
it. (Gates can also be made bidirectional.)

– You may use the New Window command to bring both the 
Process Type Game and the Block GameBlock into view at the 
same time, then Copy and Paste the text between the diagrams. 

– You may also take advantage of the Signal Dictionary window, 
and Insert the signals from the block GameBlock (Up).

4. Also make the start transition as well as the input of the signals 
Probe and Bump virtual by adding the text “VIRTUAL” before the 
name of the signal. 

– By doing this, you will later on be able to change the properties 
of the game in a smooth way.

The changes to the resulting diagram should now look something like 
this:
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Connecting to the Finished Diagram

The finished Game process type diagram is also available as the file 
game.spt. If you instead of drawing the diagram wish to use this file, 
do as follows:

1. In the SDL Editor, close the Game process type diagram.

2. In the Organizer, select the diagram Process Type Game, and then 
select Connect from the Edit menu.

Figure 161: The resulting process type Game

Process Type Game 1(1)
DCL
Count Integer;

VIRTUAL *

Count:=0 Result EndGame

Losing Score
(Count)

VIRTUAL
Probe

VIRTUAL
Bump -

Lose Winning

Count:=
Count-1

VIRTUAL
Bump

VIRTUAL
Probe

- Losing Win

Count:=
Count+1

-

G2

Win,
Lose,
Score

G5

Probe,
Result,
EndGame, 
Bump
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 Creating a Process Type from a Process
3. Select the option To an existing file. Change the filename to 
game.spt, or select this file by using the folder button. 

4. Click Connect and check the new file connection in the Organizer.

The Organizer Structure
1. Save everything. The resulting Organizer list should now resemble:

Note the presence of an instantiation symbol, looking like a normal 
symbol, but with the generic “X:Y” (meaning instance:type) nota-
tion in it. The instantiation symbol denotes that the type is actually 
instantiated somewhere in the diagram.

Instantiation symbols in the Organizer cannot be used for navigat-
ing into the system hierarchy with a double click, since they do not 
refer to diagrams. (You can use them from within the SDL Editor 
with the support from the Type Viewer tool, which you will practice 
on later in this tutorial).

2. Terminate by analyzing the system. Correct any syntactic or seman-
tic errors that are reported.

Figure 162: Resulting Organizer view

Chapter Diagram Structure

x:y Process Instance Game (0,1) : Game

Process Main rw old_main.spr

Process Type Game rw new_game.spt

Block GameBlock rw new_gameblock.s

Process Demon rw demon.spr

Block DemonBlock rw demonblock.sbk

System DemonGame rw old_demongame.
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Redefining the Properties of a Process 
Type

What You Will Learn
• To have a process type inherit properties from another process type
• To redefine transitions in a process type

The Process Type JackpotGame
So far, you have redesigned the original functionality of the system 
DemonGame, using a slightly different design. Next step will be to add 
a feature that allows you to win the “jackpot”, with a probability of 
10%. The jackpot is arbitrarily set to increase the score by 10. A simple 
implementation of this could be to create a pseudo random number gen-
erator that returns a sequence of numbers from 0 to 9, and to check the 
random number upon the reception of the signal Probe.

It should also be possible to specify what kind of game to start at run-
time, meaning that we need an additional input signal from the environ-
ment, NewJackpotGame, that will start the JackpotGame; that new sig-
nal requires additions to the process Main and the system diagram.

The JackpotGame is implemented as a process type that inherits the 
properties of the process type Game, and adds the random number fea-
ture by redefining the transitions that handle the signal Bump. The pseu-
do random generator is activated upon each reception of the signal 
Bump. See below.
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 Redefining the Properties of a Process Type
• Create the diagram above and save it on a new file 
(new_jackpotgame.spt for instance). Then close the diagram in 
the SDL Editor (Close Diagram from the File menu).

– This diagram is also available as the file jackpotgame.spt, if 
you wish to make a copy (or use it as is) instead of drawing the 
diagram.

Figure 163: The process type JackpotGame

INHERITS Game ;

Process Type JackpotGame 1(1)

DCL
Pseudo_Random INTEGER;

Winning Losing

REDEFINED
Probe

REDEFINED
Bump

Pseudo_Random=0
Pseudo_Random:=

(Pseudo_Random+7)
MOD 10

Count :=
Count+1

Count :=
Count+10 Winning

Win REDEFINED
Bump

-
Pseudo_Random:=

(Pseudo_Random+4) 
MOD 10

Losing

FALSE

TRUE
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Changes to the Block GameBlock
To make the process type JackpotGame available from the parent block, 
you simply add a process reference symbol and a process instantiation 
symbol, as you did before with the process type Game. You also add a 
signal NewJackpotGame to the signal list to the process Main.

• Update the existing diagram GameBlock according to above and 
save it on file. 

– This version of the diagram is also available as the file 
gameblock2.sbk. To use it instead of drawing the diagram, 
close the GameBlock diagram in the SDL Editor, and connect 
the GameBlock diagram in the Organizer to the new file. (Use 
Connect in the Edit menu and the option To an existing file.)

Figure 164: The block GameBlock

Block GameBlock 1(1)

Main(1,1)

Game(0,1):Game
JackpotGame(0,1):
JackpotGame

Game JackpotGame

C1
R1

Newgame,
NewJackpotGame,
Endgame,
Probe, 
Result

RBump

Bump
C3

R5

Probe, 
Result,
EndGame, 
Bump

JR5

Probe,
Result,
EndGame,
Bump

G5 G5
C2

R2

Win, Lose, Score
G2

G2

JR2Win, Lose, Score

C2
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Changes to Process Main and System 
DemonGame
The process Main and the system DemonGame need to be extended 
with the declaration of the signal NewJackpotGame and the code to re-
ceive the signal and create an instance of the game JackpotGame:

1. Update the diagrams Main and DemonGame according to the figure 
above and save them on file. You may want to save the diagrams on 
new files, e.g. new_demongame.ssy and new_main.spr.

– This version of the Main diagram is also available as the file 
main2.spr, if you wish use it instead of editing the diagram. In 
the Organizer, connect the diagram to the new file (from the Edit 
menu).

– The DemonGame diagram has to be edited manually – do 
not re-connect it to an existing file.

2. In the Organizer, make sure that the process type diagram Jackpot-
Game is connected to the file new_jackpotgame.spt that you 
created earlier. (If not, use Connect in the Edit menu and the option 
To an existing file.)

The resulting Organizer list should now look like this:

Figure 165: The extensions to process Main and system DemonGame

Game_Off

NewJackpotGame

JackpotGame

GameP:=
Offspring

Game_On

Signal
Newgame, NewJackpotGame,
Probe,
Result,Endgame,
Bump,
Win,Lose,Score(INTEGER);

C1

Newgame,
NewJackpotGame,
Probe,
Result,Endgame

Code added 
to process 
Main to han-
dle the new 
signal...

...declaration of new 
signal and addition to 
signal list on C1 in 
DemonGame
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Simulating the JackpotGame
To understand the resulting system, you may want to spend a few min-
utes simulating it.

1. First analyze the system and generate a simulator, as you learned 
from the tutorial on the simulator. Then open the generated simula-
tor in the Simulator UI.

2. We suggest that you check the following features:

– It should be possible to start one instance of Game or of 
JackpotGame at run-time using the NewGame/NewJackpot-
Game signals, but not to have two games running at the same 
time. (Use the command output-via to send the signals New-
JackpotGame, Newgame and EndGame via C1, in order to start 
and stop the game). 

– Even if we do not have any game started, the signal Bump no 
longer causes any dynamic error, since there is always a receiver 
(Main). 

– Turn the graphical MSC trace on, to visualize how the signalling 
is done. Also turn the graphical SDL trace on. Verify that the ex-
ecution takes place in the graphs for both the process types 
Game and JackpotGame, even if you have started a Jackpot-
Game! (You may have to execute at symbol level to catch this.)

Figure 166: JackpotGame added to Organizer list

x:y Process Instance Game (0,1) : Game
x:y Process Instance JackpotGame (0,1) : JackpotGame

Process Main rw new_main.spr

Process Type Game rw new_game.spt

Process Type JackpotGame rw new_jackpotgame.spt

Block GameBlock rw new_gameblock.sbk

Process Demon rw demon.spr

Block DemonBlock rw demonblock.sbk

System DemonGame rw new_demongame.ssy

Chapter Diagram Structure
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3. Play the game in a realistic way. 

– First, create a button in the Simulator UI with the name Probe, 
that sends the signals Probe and then Result, then resumes the 
execution with the command Go. Each time you click this but-
ton, the Score is returned. (The button definition should contain 
output-to Probe Main; output-to Result Main; go)

– Then, set the trace for the system to 1, meaning that only signals 
to/from the environment are traced. If required, turn all graphi-
cal traces off, in order to speed up the execution: 
set-gr-trace 0; stop-msc-log

– Send the signal NewJackpotGame and run the simulator:
output-to NewJackpotGame Main; go

– Click repeatedly the Probe button and watch the trace. You 
should win 10 points every now and then. 

4. Stop the execution with the Break button.

Figure 167: Defining the button Probe
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Adding Properties to a Process Type

What You Will Learn
• To inherit a process type and add properties
• To use dashed gates.

The Process Type DoubleGame
Even with a “jackpot” feature, winning “a lot” with the DemonGame 
takes some time... Suppose now that you would like to add a function 
that doubles the “stake” of the game, whenever you want, so that you 
have the possibility to win more. 

A way to do this is to:

1. Create a process type DoubleGame, that inherits the properties of 
the process type Game, with the following additions:

– Declaration of a variable Stake of type integer.

– Initialization of Stake to 1, by redefining the start transition.

– Reception of a signal DoubleStake that doubles the value of 
Stake.

– Redefinition of the transitions Winning and Losing to add/de-
duct the current Stake from the score Count.

2. The resulting graph is depicted below. Create it in the same way as 
you have learned from the previous exercises, and save it on the file 
new_doublegame.spt. Then close the diagram in the SDL Editor 
(Close Diagram from the File menu).

– This diagram is also available as the file double.spt, if you 
wish to make a copy (or use it as is) instead of drawing the dia-
gram.
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3. Add a process type reference symbol DoubleGame, and a process 
instantiation symbol with the text “DoubleGame (0,1):Double-
Game” to the block diagram GameBlock; see below.

– This version of the diagram is also available as the file 
gameblock3.sbk. To use it instead of drawing the diagram, 
close the GameBlock diagram in the SDL Editor, and connect 
the GameBlock diagram in the Organizer to the new file.

Note:

The diagram contains a dashed gate symbol G5, where the signal 
DoubleStake is conveyed. You use dashed gates to refer to gates that 
are already defined in the supertype (the type that you inherit from), 
to distinguish from situations where you have to add a new gate. 

To dash a gate:

• Make sure the gate is selected.

• Select the Dash command from the Edit menu of the SDL Editor 
(this command toggles between Dash/Undash).

Figure 168: The process type DoubleGame

INHERITS Game;

Process Type DoubleGame 1(1)

DCL
Stake INTEGER;

*

DoubleStake

Stake:=Stake*2

-

Losing

REDEFINED
Probe

Lose

Count:=
Count-Stake

-

REDEFINED

Count:=0,
Stake:=1

Losing

Winning

REDEFINED
Probe

Win

Count:=
Count+Stake

-

G5

DoubleStake
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4. Also add the signals NewDoubleGame and DoubleStake to the sig-
nal list on the signal route R1, and DoubleStake to the signal list to 
the process DoubleGame; see below.

5. Add the new signals NewDoubleGame and DoubleStake at the sys-
tem level (in the DemonGame diagram), both in the signal declara-
tion, and in the signal list on the channel C1.

– You have to make these changes yourself.

Figure 169: The resulting block GameBlock

Block GameBlock 1(1)

Main(1,1)

Game(0,1):Game
JackpotGame(0,1):
JackpotGame

DoubleGame(0,1):
DoubleGame

Game JackpotGame DoubleGame

C1
R1

Newgame,
NewJackpotGame,
NewDoubleGame,
Endgame,
Probe, 
Result,
DoubleStake

R5

Probe, 
Result,
EndGame, 
Bump

G5
R2

Win, 
Lose, 
Score

G2C2

JR5

Probe,
Result,
EndGame,
Bump

G5

JR2Win, Lose, Score

G2

C2

DR5 Probe,
Result,
EndGame,
Bump,
DoubleStake

G5

DR2Win, Lose, Score

G2

C2

C3
RBump

Bump
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6. Extend the process Main with the code to receive the signal 
DoubleStake, and the code to receive the signal NewDoubleGame 
and create an instance of the game DoubleGame; see below.

– This version of the Main diagram is also available as the file 
main3.spr, if you wish use it instead of editing the diagram. In 
the Organizer, connect the diagram to this file.

7. If needed in the Organizer, connect the process type diagram Dou-
bleGame to the file new_doublegame.spt that you created earlier.

Simulating the DoubleGame
You may simulate the DoubleGame in a similar way as the 
JackpotGame (the DoubleGame is started with the signal 
NewDoubleGame). 

1. To play the game in a realistic way, also add a button Double to the 
Simulator UI, with the text “Double” and the command 
Output-to DoubleStake Main; go

2. Try for instance the following tactic: whenever your score is nega-
tive, double the stake.

Figure 170: New code in process Main

Game_On

DoubleStake

DoubleStake
TO GameP

Game_On

Game_Off

NewDoubleGame

DoubleGame

GameP:=
Offspring

Game_On

Code added 
to process 
Main to han-
dle the new 
signals.
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Combining the Properties of Two Process 
Types

What You Will Learn
• To work with the Type Viewer (the “class browser” in the SDL 

suite)
• To inherit process types in more than one level

So far, you have created a basic version of the game (the supertype pro-
cess type Game), and extended it as two subtypes (the process types 
JackpotGame and DoubleGame). To assist you in understanding the in-
heritance and instantiation of types, the SDL suite is provided with a 
“class browser”, the Type Viewer.

Working with the Type Viewer
1. Open the Type Viewer with the command Type Viewer from the Or-

ganizer’s Tools > SDL menu. 

The Type Viewer is started and displays two windows: the main 
window, where all types are listed, and the Type Trees, where the 
inheritance and instantiation of the types is visualized.
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 Combining the Properties of Two Process Types
The main window displays a list of all types and instances that exist in 
your current system. When selecting an object in the main window, the 
Type Trees window is updated to show the inheritance tree for that type.

Figure 171: The two windows of the Type Viewer
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Figure 172 shows an inheritance tree for the process types Game, 
JackpotGame and DoubleGame. We have one level of inheritance, as 
depicted above. You can also note that the Type Viewer keeps track 
about the types that have been instantiated somewhere in the SDL sys-
tem. 

– You may go to the source SDL graphs and find the declarations 
and instantiations of the types by double clicking the symbols in 
the Type Viewer.

How to Work-Around the Lack for Multiple 
Inheritance
Say that you would like to design a new game where both the “jackpot” 
and the “double” features are supported. As SDL-92 does not support 
multiple inheritance, we cannot simply create a SuperGame that inherits 
JackpotGame and DoubleGame. Instead, we will have to inherit from, 
i.e. reuse, the JackpotGame or the DoubleGame, and then redefine/add 
some of the properties. (The idea is to rewrite as little code as possible).

Which one should we reuse as is? The code for the DoubleGame seems 
to be still valid for the SuperGame. So, let us inherit that process type, 
and redefine some of the properties in accordance to the JackpotGame.

Figure 172: The inheritance tree for the process type Game

_______________Inheritance tree_______________

x:y

Process Instance
Game(0,1)

x:y

Process Instance
JackpotGame(0,1)

Process Type
JackpotGame

x:y

Process Instance
DoubleGame(0,1)

Process Type
DoubleGame

Process Type
Game
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 Combining the Properties of Two Process Types
To create the SuperGame:

1. Open the process type JackpotGame in the SDL Editor, and Save As 
on a new file, e.g. new_supergame.spt

– This diagram is also available as the file supergame.spt, if 
you wish to make a copy (or use it as is) instead of drawing the 
diagram. In that case, continue with step 6. below.

2. Rename the diagram to process type SuperGame.

3. Change the inheritance from “INHERITS Game” to “INHERITS 
DoubleGame”.

4. Update the contents of the graph, in order to:

– Change the branch Winning/Probe so that you add Stake instead 
of 1 to Count when winning, and reward you with 10 times the 
value of Stake when winning the jackpot.

– Redefine the transition Losing/Probe so that you deduct Stake 
instead of 1 from Count.

Figure 173: The changes to the process type SuperGame

Winning

REDEFINED
Probe

Pseudo_Random=0

Count :=
Count+Stake

Win

-

Count :=
Count+

(10*Stake)

Losing

REDEFINED
Bump

Pseudo_Random:=
(Pseudo_Random+7)

MOD 10

Winning

REDEFINED
Bump

Pseudo_Random:=
(Pseudo_Random+4) 

MOD 10

Losing

Losing

REDEFINED
Probe

Lose

Count:=
Count-Stake

-

FALSE

TRUE
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5. If the Process Type JackpotGame has become unconnected in the 
Organizer, re-connect it to the file used earlier 
(new_jackpotgame.spt).

6. Also add a process type reference symbol with the name 
SuperGame in the diagram GameBlock. In the Organizer, then con-
nect the newly added process type diagram SuperGame to the file 
new_supergame.spt that you created earlier.

7. You may check the impact of the changes above in the Type View-
er. Save everything and the select Update from the Type Viewer’s 
File menu (since the Type Viewer does not automatically update its 
content when you make changes to a diagram). Your inheritance 
tree should now look like this:

8. If you want to be able to play the SuperGame, you must also add a 
process instantiation symbol “SuperGame(0,1):SuperGame” in the 
GameBlock, and add a signal NewSuperGame that starts the game 
(in a similar fashion as you did in the JackpotGame and the Double-
Game). Do not forget to update the system diagram.

– These versions of the diagrams are also available as the files 
gameblock.sbk and demongame.ssy, if you wish use them 
instead of editing the diagrams. In the Organizer, connect the di-
agrams to the new files. A complete and final system file, 
demongame_sdl92.sdt, is also available, with connections to 
the final SDL diagrams.

Figure 174: The process type SuperGame, added

_______________Inheritance tree_______________

x:y

Process Instance
Game(0,1)

x:y

Process Instance
JackpotGame(0,1)

Process Type
JackpotGame

x:y

Process Instance
DoubleGame(0,1)

Process Type
SuperGame

Process Type
DoubleGame

Process Type
Game
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Using Packages and Block Types

What You Will Learn
• To create a package diagram
• To use a package in a system
• To refer to and instantiate a block type
• To define a process type as virtual

Package – a Reusable Component
Packages are used to make type definitions available in different sys-
tems, and to make components reusable. You will take advantage of the 
package concept by developing two versions of the DemonGame, one 
that has only the basic “Probe” feature, and one that also includes the 
“Jackpot” and “DoubleStake” features.

The idea here is to develop a package “BasicFeatures” that is used in the 
basic version and that is reusable to 100% in the advanced version.

Using packages to their full extent in this example requires not only the 
process Game to be transformed to a process type (as you have done in 
the previous exercises, when creating the JackpotGame, DoubleGame 
and SuperGame), but also to transform the process Main and the block 
GameBlock to reusable process type and block type, respectively. 

You have probably noticed that the process type Main also requires to 
be extended for each feature that we add (“jackpot”, “double”, etc.), so 
it would be a good idea to make a reusable type of it. This has already 
been prepared for you, so your task will be to add the required “glue” to 
build the two packages.

1. Start by copying the files gameblock.sbt and main.spt from 
the directory 
$telelogic/sdt/examples/demongame/sdl92/packages (on 
UNIX), or 
C:\Telelogic\SDL_TTCN_Suite4.5\sdt\examples\demongam
e\sdl92\packages (in Windows) to the same directory you creat-
ed earlier for this tutorial.

– All diagrams in the remaining exercises are available in the 
above directory. You may choose to copy them if you do not 
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want to draw all diagrams, and then connect the created diagram 
symbols in the Organizer to the corresponding files.

Creating a Package
To create a package:

1. Select the Add New command from the Organizer’s Edit menu. In 
the Add New dialog, specify document type as SDL Package, and 
document name as BasicFeatures.

As you click OK, a new diagram structure is created in the Organiz-
er with the package diagram as root diagram. (The Organizer sup-
ports managing multiple structures in the same system file.)

The newly created package should contain the generic properties for 
the DemonGame; namely:

– The declaration of the signal interface between the “basic” 
DemonGame and the environment, as well as a process type 
Main that supports the signal interface.

– The definition of the process type Game with the basic function-
ality.

– A block type that contains the process types.

Figure 175: Adding a new package Basic Features
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2. With the SDL Editor, move the declaration of the signals from the 
system diagram to the package diagram. Also add the process type 
reference symbol Game and the block type reference symbol 
BasicGameBlock to the package diagram. See below.

3. Save the package diagram on a file, e.g. basicfeatures.sun

4. With the Organizer, connect the block type BasicGameBlock to the 
recently copied file gameblock.sbt (the diagram is depicted in 
Figure 177).

– Note that the process type Main is declared as VIRTUAL. This 
is essential since we are going to add properties to Main, and 
need to address signals from the environment to Main, without 
changing its name to e.g. “SuperMain” (compare to how you did 
for the process type Game that was specialized into 
JackpotGame, etc.). By defining a process type as VIRTUAL, 
we can later add properties without changing its name, using the 

Figure 176: The package BasicFeatures

Package BasicFeatures 1(1)

Signal
Newgame,
Probe,
Result,Endgame,
Bump,
Win,Lose,Score(INTEGER);

Game

BasicGameBlock
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keyword REDEFINED (you will practice that in a few mo-
ments, in “Redefined Process Type Main” on page 263).

5. You should also connect the process type Main to the copied file 
main.spt (This may already have been done if you had Expand 
Substructure turned on in the Connect dialog in the previous step.)

Figure 177: The block type BasicGameBlock

Block Type BasicGameBlock 1(1)

VIRTUAL Main

Main(1,1):
Main

Game(0,1):
Game

G1

Newgame,
Endgame,
Probe, 
Result

R1
Newgame,
Endgame,
Probe, 
Result

G1
G3

RBump

Bump

G3

Bump
G5

R5
Probe, 
Result,
EndGame, 
Bump

G5

G2

R2

Win, Lose, Score

G2 Win, Lose, Score
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Using a Package
To use a package, you add a USE statement to the package reference 
symbol (looking like a text symbol immediately outside the frame sym-
bol). 

1. To create a version of the DemonGame that has the basic features, 
add a USE statement to the system diagram. Also remember to in-
stantiate the block type BasicGameBlock (which is contained in the 
package). See below.

– You may want to save the system diagram on a new file, e.g. 
basicdemongame.ssy

2. In the Organizer, Disconnect the old GameBlock from the system 
structure. The resulting Organizer view should now be something 
like this (the order of appearance of symbols may differ):

Figure 178: USE of packages

USE BasicFeatures;

System BasicDemongame 1(1)

GameBlock:
BasicGameBlock

DemonBlock

C1

Newgame,
Probe,
Result,Endgame

G1

C2

Win,Lose,Score
G2

C3
Bump

G3
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3. Terminate the exercise by analyzing the resulting system.

Reusing Packages
When developing the version of the DemonGame that has all features, 
you create a package AdvancedFeatures that contains the additional fea-
tures and that will reuse the package BasicFeatures.

What You will Learn
• To reuse a package in another package
• To inherit a block type
• To redefine a process type

Figure 179: System BasicDemonGame using package BasicFeatures

Note:

You may analyze the package (by selecting the package symbol in 
the Organizer as input to the Analyzer before ordering the Analyze 
command), in which case a partial semantic analysis will be done 
on the package. (The Analyzer will not check the consistency be-
tween the package and the system that uses it.)

A complete semantic analysis requires the system diagram to be se-
lected before ordering Analyze.

Chapter Diagram Structure

x:y Process Instance Game (0,1) : Game
x:y Process Instance Main (1,1) : Main

Virtual Process Type Main rw main.spt

Block Type BasicGameBlock rw gameblock.sbt

Process Type Game rw new_game.spt

Package BasicFeatures rw basicfeatures.sun

x:y Block Instance GameBlock : BasicGameBlock

Process Demon rw demon.spr

Block DemonBlock rw demonblock.sbk

System BasicDemongame rw basicdemongame.ssy
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The Package AdvancedFeatures
1. Create the package AdvancedFeatures in a similar fashion as the 

package BasicFeatures (see Figure 175 on page 256). 

– You should now have two package structures in the Organizer, 
BasicFeatures and AdvancedFeatures.

The package AdvancedFeatures must do the following:

2. Use the package BasicFeatures.

3. Add the declarations of the new signals.

4. Add references to the process types JackpotGame, etc.

5. Add a reference to a block type AdvancedGameBlock (which inher-
its the block type BasicGameBlock and in turn refers to a redefined 
process type Main).

6. Save the package diagram on the file advancedfeatures.sun

Figure 180: The package AdvancedFeatures

USE BasicFeatures;

Package AdvancedFeatures 1(1)

Signal
DoubleStake,
NewJackpotGame,
NewDoubleGame,
NewSuperGame;

JackpotGame

DoubleGame

AdvancedGameBlock
SuperGame
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Block Type AdvancedGameBlock
The diagram contains a reference to a REDEFINED process type Main, 
and a dashed instantiation symbol Main.

Figure 181: Block type AdvancedGameBlock

INHERITS BasicGameBlock;

Block Type AdvancedGameBlock 1(1)

Main

DoubleGame (0,1):
DoubleGame

JackpotGame(0,1):
JackpotGame

SuperGame (0,1):
SuperGame

REDEFINED
Main

G1

Newgame,
NewJackpotGame,
NewDoubleGame,
Endgame,
Probe, Result,
DoubleStake,
NewSuperGame

AR1

Newgame,
NewJackpotGame,
NewDoubleGame,
Endgame,
Probe, Result,
DoubleStake,
NewSuperGame

G1

DR5

Probe, 
Result,
EndGame,
Bump,
DoubleStake

G5

G5

DR2

Win, Lose, Score

G2

G2

Win, 
Lose, 
Score

JR5
Probe, 
Result,
EndGame,
Bump

G5

G5

JR2

Win,
Lose,
Score

G2

SR5
Probe, 
Result,
EndGame,
Bump,
DoubleStake

G5

G5

SR2

Win, Lose, Score

G2
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• The block type AdvancedGameBlock is already provided on the file 
advancedgameblock.sbt. Copy that file from the directory 
$telelogic/sdt/examples/demongame/sdl92/packages (on 
UNIX), or 
C:\Telelogic\SDL_TTCN_Suite4.5\sdt\examples\demongam

e\sdl92\packages (in Windows), and use the Organizer to con-
nect the diagram to the file.

Redefined Process Type Main
The REDEFINED process type Main inherits implicitly from the 
VIRTUAL process type Main in the package BasicFeatures, and adds 
the code to receive the signals that command the new features.

• The REDEFINED process type Main is also provided on the file 
advancedmain.spt in the directory
$telelogic/sdt/examples/demongame/sdl92/packages (on 
UNIX), or 
C:\Telelogic\SDL_TTCN_Suite4.5\sdt\examples\demongam

e\sdl92\packages (in Windows). Copy the file and use the Orga-
nizer to connect the diagram to the file.

Figure 182: The redefined process type Main

REDEFINED Process Type Main 1(1)

Game_Off

NewJackpotGame

JackpotGame

GameP:=
Offspring

Game_On

NewDoubleGame

DoubleGame

GameP:=
Offspring

Game_On

NewSuperGame

SuperGame

GameP:=
Offspring

Game_On

Game_On

DoubleStake

DoubleStake
TO GameP

Game_On

G1

NewJackpotGame,
NewDoubleGame,
DoubleStake,
NewSuperGame

G5

DoubleStake
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Creating the System AdvancedDemonGame
Creating the system is now fairly simple.

1. Add a New SDL system in the Organizer. Say you name the system 
AdvancedDemonGame and save it as demongameadvanced.ssy

2. With the SDL Editor, Copy the contents of the system 
BasicDemonGame and Paste them into the new system.

3. Have the system USE AdvancedFeatures in addition to 
BasicFeatures.

4. Change the reference from the block type BasicGameBlock to 
AdvancedGameBlock.

5. Update the signal list C1 with the new signals JackpotGame, etc. 
The system is now complete. Analyze it and simulate it if you find 
it meaningful.

Figure 183: The system AdvancedDemonGame

USE BasicFeatures;
USE AdvancedFeatures;

System AdvancedDemongame 1(1)

AdvancedGameBlock:
AdvancedGameBlock

DemonBlock

C1

Newgame,
NewJackpotGame,
NewDoubleGame,
Probe,
Result,Endgame,
DoubleStake,
NewSuperGame

G1

C2

Win,Lose,Score
G2

C3
Bump

G3
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 Conclusion
Conclusion
The SDL-92 session of this tutorial has shown how to design a (small) 
SDL system so that the result becomes reusable components, which in 
turn reduces the effort needed to maintain and extend the functionality.

The tutorial also illustrates the need to design the system properly in or-
der to introduce the OO paradigm in a smooth way.

To verify that you have assimilated the SDL-92 tutorial, you should 
now be ready to add new features on your own, without having to re-
write the whole system. 

More Exercises...
As a “menu” of new features that can be introduced, we suggest that you 
try to extend the AdvancedDemonGame with the following:

1. Memorization of “highest score ever” since system start (there 
should be only one highest score, common for all types of games).

2. A “hall of fame” that memorizes the name of the player that reaches 
the “highest score ever”. (The name is assumed to be provided by 
the environment).

3. A “gameover” function that checks if the current score is less than 
an arbitrary value of, say -100, and disables the game so that the 
player needs to restart it entirely.

Good luck!

Note:

A suggestion for a solution for the exercises above can be found in 
the directory: 
$telelogic/sdt/examples/demongame/sdl92/exercises (on 
UNIX), or 
C:\Telelogic\SDL_TTCN_Suite4.5\sdt\examples\demongam

e\sdl92\exercises (in Windows)
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Appendix: Diagrams for the DemonGame 
Using Packages

Figure 184: Hierarchical structure

Chapter Diagram Structure (basic)

Process Type Game rw game.spt

x:y Process Instance Game (0,1) : Game

x:y Process Instance Main (1,1) : Main

Virtual Process Type Main rw main.spt

Block Type BasicGameBlock rw gameblock.sbt

Package BasicFeatures rw basicfeatures.sun

x:y Block Instance GameBlock : BasicGameBlock

Process Demon rw demon.spr

Block DemonBlock rw demonblock.sbk

System BasicDemongame rw basicdemongame.ssy

Chapter Diagram Structure (advanced)

Process Type JackpotGame rw jackpotgame.spt

Process Type DoubleGame rw double.spt

x:y Process Instance DoubleGame (0,1) : DoubleGame

x:y Process Instance JackpotGame (0,1) : JackpotGame

Process Instance Main

x:y Process Instance SuperGame (0,1) : SuperGame

Redefined Process Type Main rw advancedmain.spt

Block Type AdvancedGameBlock rw advancedgameblock.sbt

Process Type SuperGame rw supergame.spt

Package AdvancedFeatures rw advancedfeatures.sun

x:y Block Instance AdvancedGameBlock : AdvancedGameBlock

Process Demon rw demon.spr

Block DemonBlock rw demonblock.sbk

System AdvancedDemongame rw demongameadvanced.ssy
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 Appendix: Diagrams for the DemonGame Using Packages
(The inheritance tree for the process type Game is displayed in 
Figure 172 on page 252.)

Figure 185: Inheritance tree for the block type and process type Main

_______________Inheritance tree_______________

x:y

Block Instance
GameBlock

x:y

Block Instance
AdvancedGameBlock

Block Type
AdvancedGameBlock

Block Type
BasicGameBlock

_______________Inheritance tree_______________

x:y

Process Instance
Main(1,1)

Redefined Process Type
Main

Virtual Process Type
Main
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